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Agenda

* Getting Started

* Recording & Test Generation
* Executing Tests

* Reports

* Troubleshooting




Rational Performance Tester

Comprehensive test planning, authoring, and analysis to identify and
manage the risk of application performance failures

1. Capture and track Business
SLAs in your test plans

2. Create realistic user
workloads that exercise the
key business transactions

System Under Test

3. Automatically deploy the
environment and schedule
execution of your workload

Web Server  App Server dB Server

4. ldentify the root cause of
performance problems

5. Communicate results and
areas of non-compliance to
the stakeholders

I ..o




Tip — Take Baby Steps

* Running too many users too soon can mask lots of
problems

—Login failures
—Server failures
—Dynamic data failures
—Duplicate keys

*The Solution
—1 User — is dynamic data handled correctly?
—2 Users — data that has to be unique using a datapool?
—10 Users — does login need to be staggered?
—50 Users — effect on agent & server cpu/memory as you increase users?

—100 Users — is your agent sized correctly for target load?




Tip — Performance Test Driven
Development

* Performance Test Early & Often
e Easier to address issues if found right after delivery
* Less costly to fix than when found late in development
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Test Creation Tips

. Delete Browsing History [5_(|
* Clear browser cache & cookies —

Temporary Internet Files

. Copies of webpages, images, and media that Delete files. .. |
—Browser responds with content, not 304 R e (
Cookies
Files stored on your computer by websites ko ’ Delete conkies. . ]

save preferences such as login information,

* Pause between pages (3-5 seconds)

History

_Pages Clea rIy Sepa rated in the test List of websites o have visited. ’ Delete hiSt':'r':""" ]

Form data
Saved information that you have tvped into ’ Delete Farms. .. ]
Forms.

* Mouse hovers

Passwords
—_ M ay resu It IN Unwa nted server a Ct|V|ty F‘asslwcurds that are e!utu:umallzically Filled ini when ’ Delete passwords. .. ]
E;jsli-ll:e?jg on ko & website you've previously

—Real application users are going to cause this
sort of spurious activity

About deleting browsing hiskory: ’ Delete all... ] ’ Close ]




Creating a Test - Recording

(= Rational Performance Tester Recorder, - Windows Internet Explorer

pr S——

Sk o E Zi\rkc-warkspace-8, 2ycom.ibm, rational . kest, k. corelnlientreadme. btml

File Edit Wew Favorites Tools  Help Recorder Test Annatation A E!s = E ':E'-;

e Comments
—Add context if page name n
* Start Transaction
—Groups related acti
* Stop Transaction
* Name pages
—Makes th
* Split test
—Modularity for sharing assets

St more readable

—Split login & logout from application




Color

Window > Preferences > Test >
Test Editor

Examp

Example of Datapool candidake,
Example of EEM

Exarple of Unused reference,
Example of Substituted - Custorn code.
Exarmple of Substituked - Reference,
Exarple of Substituted - Test Yariable,

Example of Substituked - Built-in Yariable,
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How RPT Recording Works

* SOCKS proxy recorder

Proxy Settings

Servers

B Tvps Procey address to use Port

WE
Hrre: | || |
Secure: | | : | |
ees L]
Sogks: | 127.0.0.1 ¢ o0 |

e

[]Use the same proxy server for all protocols

Exceplions

Do nok use proxy server for addresses beginning with:

Ise semicolons ¢ ; ) to separate entries,

3

[ O, ] [ Cancel

IBM Software
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Local Area Network [LAN) Settings

Autornatic configuration

Automatic configuration may override manual setkings, To ensure the
use of manual settings, disable automatic configuration.

[ lautomatically detect settings:

|:| IJse automatic configuration script

Proxy server

Ise a progy server for wour LAN (These settings will nok apply to
dial-up or YPM connections),

|:| Advanced

[ |Bypass proxy server for local addresses

¥
(]

[ Ok l [ Cancel

]




Recorder Missing Some or All Dat

* Check registry settings

—Tools > Internet Options > Connections > LAN Settings > Advanced
—Socks proxy should be chosen, port 1080

* Some portion of the application, like an applet, does
not use the browser’s connection settings

—Try to configure the applet to use the proxy server
—May be able to verify with wireshark
—RPT socket recording may be an alternative




Assets

* A workspace and project cannot be shared directly with others for

Best Practices for Sharing Test "

read/write
» Users with their own workspace can import a shared project for

read-only usage such as test execution
* Projects can be versioned and shared through integration with

Rational Team Concert
http://www.ibm.com/developerworks/rational/library/09/integraterationaltea
mconcertandrationalperformancetester/index.html?ca=drs-
* Provide a copy of test assets using File > Export > Test > Test Asset
with Dependencies. Import likewise.
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Data-Correlation View Mode

. Test - test
o Edltor tree ShOWS Only Test Contents (filtered)
. . This section shows the test contents
substitutions and datapool oo 5 | options -
Candldates ki I%Slit) t | Candidate " d": "IBM i ! A
atapool Candidate "command": performance
. . . . % Datapool Candidate "p": "ibm performance tester”
L4 Use Wlth QU|Ck Fl Iter to easli Iy =4 Substituter "ibm performance test_url®; "/search?fr=yfp-t-701-s8taggle
I . . d o Substituter "Referer_26": "http:/fsearch.yahoo.com/search?fr=yfp-t-7C
Ocate |nte rest' N ata =4 Substituter "p": "ibm performance tester" R
g %2 Datapool Candidate "title"; "IBM Rational Performance Tester Tutarial T
. . o#) Substituter "Refarer_28": "hitp://search.yahoo.com/search? fr=yfp-t-7C U
b SU bStItUte a nd remOVG/m Od |fy o#) Substituter "Refarer_24": "hitp://search.yahoo.com/search? fr=yfp-t-7C
. . %2 Datapool Candidate "ref': "http://search,yahoo.com/search? fr=yfp-t-7i0
SuU bstltutlon on one or more %3 Datapool Candidate "ref': "http://search.yahoo.com/search? fr=yfp-t-71
%2 Datapool Candidate "ref': "http://search,yahoo.com/search? fr=yfp-t-7i0
Iocatlons %2 Datapool Candidate "utmdt": "IBM Rational Performance Tester Tutorial
%2 Datapool Candidate "utmr': "http: //search.yahoo, com/search?fr=yfp-t-
. . e Datapool Candidate "utmcc™: " utma=134961636. 75634412, 12657 260:
¢ Flnd Where a data-SOUFCG |S USEd o4 Substituter "Referer_4": "http:/fgoogleads.g.duuhleclick.net/pagead/ad
o4 Substituter "Referer_3" "http: //googleads.g.doubleclick.net/pagead/ad
H H =7 Substituter "Referer_2": "http://googleads.g.doubleclick.net/pagead/ad —
» Switch to Data-Correlation Mode

=4 Substituter "Referer™: "http://googleads.g.doubleclick.net/pagead/ads™

and back to Full Test Contents
Mode:

— Context menu

— “View” button

IBM Software
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Tip — Compare Test Data with PIayISx
Data

[% Problerns | [ Protocol Data 52 @~ Recording Cuntrnq@[ﬁata Correlation Rules Lu:ugﬂ o w | 4L 4 | o ok <= o | M [ 'FE| ['ﬁ']
| Request | Response Headers | Respanse Content | Browser | Ewvent Ll:ng|

IDOCTYPE HTRAL PUBLIC - /30 DTD HTRL 4.0 Transitional //EM" =
<HTRL =

<HEAD > <TITLE=>DCDernol </ TITLE = </HEAD =
<BODY BGCOLOR="#FDFSEG" =

ey S IR R | P W

Text Compare

Clipboard Contents

4% 8a]

Protocol Data Selection
pass=1LevelEventDispatcherlevelEventDispatch
foo id=jgENiraNn=ia

pass=1LevelEventDispatcherlevelEventDisp
LevelEventDispatcherLevelEve

foo id=FEiuritlevelEventDispatcherleve.




Data Correlation Rules

@ Data Correlation Rules: myrules10_2
[ Append  + 25 Insert f‘_&| ﬁ|

This section showes the data correlation rules that this file defines

Rule Set

A |
t 4+ B

Enter filter text

.. Rule Argurnents

4 53 Rule Pass
4 32 Link with substitutions
EEI Create a substitution - substl - src="&uniqueld=[.*?)%

* Organize related test

rl E‘ﬂ Create a reference - refl - src="=1BLAHBLAHId1=[.*?)B'

changes
* Respond more rapidly to

frequently changing
applications
* Reduce test editing




saved as

@l Test Editor - Data-Correlation Rule Sets

Tip — Auto Generated Rules

.-"._.'\.
| |
@
Wéould you like to review th
[T Do not collect data for rules {can be re-enabled from editor context menu)

ccumulated data carrelation rule

Changes you make to data correlation can b
Mo

1

Yes

* Performance Tester
monitors your manual test

edits
e Rules can be viewed when

you save your test
* Great way to begin with
rules if you don’t know
how to get started
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Execution — Workbench and Agent ==

Setup with a Firewall

* Firewalls on the workbench and agents must be
configured to:

—Allow ephemeral ports on the workbench to connect to
ports 10002 and 10005 on the agent

—Allow ephemeral ports on the agent to connect to a
range on the workbench

*\Windows > Preferences > Agent Controller > Firewall
Settings

*Specify a starting point for the range of ephemeral ports

—Allow the agent to reach the server you are testing
(ports 80 or 443 typically)




Test Log

» Best Practice in Production * For Debug Only
—Large numbers of users —Very small number of users
—Best performance —Great detail

Schedule Element Details Schedule Element Details

Schedule_Mondary Schedule_Monday

. . . . C L *r
Think Time | Resource Monitoring | Statiskics m 3 Think Time [Resaurce Monitaring [ Statistics m>3

What to Log Log Level what to Log Log Level
5 )
Show errars and Failures |F'.|| Show errors and Failures |F'-|| b |
flsa show warnings |F'.II &lso show warnings |.ﬁ.II b |
and also shiow all okher bypes |Primary Test Actions &nd also show all ather bypes |.ﬁ.|| o |
Only sample information From a subset of users [Jonky sample information From a subset of users:

(%) Fixed number of users: pErF USEr group Fixed rurmber of users:

\JPercentage of users: Percentage af users:

1EM Softwaers

Innovate Nextj'; NOW!




Loops

* Schedule e Tests
—Start new connections on each —Re-use connections on each
iteration iteration

—Increased server workload

Performance Schedule - Test - google

Test Contents

Schedule Contents
This section shiows the test contents

This section shows the schedule conkents = %E
= % schedule_Manday Ul Test variahbles
O User Group 1 (90%) =1-(_¥ Laop (infinite)
= ﬁ:ﬁ User Group 2 (10%:) L& Google

=-Cr Loop {infinite )
Ei purchase

Next\{; NOW!
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SmartLoad

Schedule Element Details

b Stage Schedule_Monday
—Time period with specified number of users (ESAWTEI, Think Time | Resource Monikoring | Statistics | Test Log | 2 A
* Users IUsers | Stage Duration hange Rate Settle Time
—How many users should run at the same timme L5 10 Minutes AlT inute 30 Seconds :
during the stage A 5o 10 Minutes AT Minute 30 5econd | LEQE
: ; . .
— It is not how many users to add or subtract L 0 2econds
* Stage Duration
—How long the sta
— It is not the time at which the stage should begi
— It begins AFTER all users have been starte
the stage and AFTER any Settle Tim
* Change Rate
. Show Bdvanced
— How quickly users sh
Time limit: For a user to respond to a stop request: |3IZI |Secnnu:|s L

— Default is to startall users as fast as possi

—All / 1 Minute means users for the s
added or removed in a random
over 1 minute

e Settle Time

—How long to dela
Duration

Ilser Load Preview

orm fashion

efore beginning Stage

— Affects when the time range for the stage is 0 .
created

— Allows the System Under Test to “settle” after
the disruption of changing the number of users
running

T
I 10 20 30
Run duration [rmin]

| £




Schedule Stages Example Reporf

Lu

&

| %

Schstages_0527 Schstages_0S27 - Performance Report 25

Page Throughput

Page Hit Rate

25

20

s

10

[
—

Tirne [s]

225

O Page Atternpt Rate [per second] [For Interval] [ Page Hit Rate [per second] [For Interal]

Performance Summary

Next\{; NOW!




Schedule Stages Best Practices
* More than one stage?

—Designed to compare steady state
behavior at multiple user load levels
—Loop required — you do not want
users to finish workload

—Loop infinite — use time (duration)
to control when the run ends

Performance Schedule - Schsip
. . . Schedule Contents
Run Until Finished
—Only if there is one stage

This section shows the schedule contents
= PE; Schsip

Schedule Element Details
Schsip
(TP Tk Time | ™%
= f_ﬁfi' User Group 1 (100%:)
EIE]I Users
e
= Select
Mhink Time | Resource Manitari
Users Skage Duration
¥ 5 Until Finished

S50
100
A1 500

Skage Duration
10 Minutes

10 Minutes

10 Minutes



Tips for Top Performance

* Never drive load from the RPT User
Interface workbench machine

e Stay below 1200m workbench heap

—Default is half physical memory up to 1024m
—Set in eclipse.ini with maximum 1200m

Page Element Response vs. Time

—Exceeding can ironically introduce out of men /

* Agent computer maximum heap

—Up to 1500m Windows
—Up to 3000m Linux

—Set using RPT_VMARGS general property in tt .
editor

* Increase Linux per process file lim

O Awerage Response Time For Al Il Page Elerments [rris] [Far Interyal 1]

—Default is 1024. Increase to 10,000 — 30,000.




Windows XP & 2003 TCP/IP Tuning
Recommendations
* Make sure you have sufficient # of TCP/IP ports

—On Windows drivers the limit is typically 5000
—Use the netstat -a command to observe port usage

during run
—|If the largest number you see is 5000 then you have a

* You can increase it by adding a registry entry (need to reboot for

problem!
it to take effect!)
HKEY LOCAL_MACHINE > SYSTEM > CurrentControlSet >
Services > Tcpip > Parameters > MaxUserPort
(dword, default is 5000, max is 65534)




* How can | take advantage of a hot box with lots of
memory?

Trick: Multiple engines on one bo

* RPT can run more then one engine as long as the
hostname is different
for the hostname

* Create another location for that box using the IP address

* Example (scooby IP is 9.42.117.101)
—Name: scoobyl

Name: scooby?2
—Hostname: scooby.rtp.ibm.com Hostname:
9.42.117.101

Innovate?

e Use hosts file for more than two engines

Nextij NOW!

T



Engine Room — Unsupported Trick

g
ﬂ RPT Engine Room - Mozilla Firefox

File Edit View History Bookmarks Tools Help

@ - G X N Q I:;&* | || http://adama.rtp.raleigh.ibm.com:1903/

£, Most Visited || Getting Started ., Latest Headlines

| | RPT Engine Room

|
o+
[+

Engine Counters

Subsystems

Runner

Actions

Engine Counters

Virtual Testers:
Average CPU

Bytes sent:

Bytes received:

Bytes sent per second
Bytes received per second
KB in use

KB per user

Process VM KB Average
Process VM KB per user
Process VM KB Peak
JVM Heap KB

JVM Heap per user

JVM Heap maximum
Connections opened
Connections closed

I/0 Retries

Innovate(

N

100
0.49
5109586
313757396
565.0
34756.0
11183.25
111
66072.26
660
76820
19172.97
191
24051712
1772
1772
1772

RPT Engine Room on adama

Nex tf; NOW!

Point browser to port 1903

Action queue size 4]
Actions per second 192
Subsystems

Engine Status

Time in test: 635594

Wait subsystem: Thread[Kernel Wait,5,main]: WORKING, current: Executing A1DE659AF
I/0 subsystem:

1: Thread[Kernel NIO 0,5,main]: OK, current: select(10000) keys=1, last: Process x
2: Thread[Kernel NIO 1,5,main]: OK, current: select (10000) keys=1, last: Process :
3: Thread[Kernel NIO 2,5,main]: OK, current: select(10000) keys=1, last: Process :x

Other subsystems:
Thread[SyncPointSubsystem, 5,main]: OK, current: Waiting for arrivals., last: Waiti

Brotherhood of RPT Engine Workers: 10 brothers are gainfully employed
Thread[Brother-9,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kb9.jpg
Thread[Brother-10,5,Engine]: COK, current: Idle, last: 10.1.1.1/perseus/20kbl2.gif
Thread[Brother-8,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kb7.3jpg
Thread[Brother-7,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kbl0.jpg
Thread[Brother-6,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kbl2.gif
Thread[Brother-5,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kb8.3jpg
Thread[Brother-4,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kbll.jpg
Thread[Brother-3,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kbll.jpg
Thread[Brother-2,5,Engine]: OK, current: Idle, last: 10.1.1.1/perseus/20kb9.jpg
Thread[Brother-1,5,Engine]: OK, current: Idle, last: PacedLoop Iteration Delay

Runner

Actions

test.Schbenchwin7491348258849741272_ Schedule DCS55DF7858937DBSOSEBA3509F3A11DB chil
User Group 1 childCount=100 childrenFinished=0 stopReg=false
[User Group 1] [000001] childCount=2 childrenFinished=1 stopReqg=false
Default Scenario childCount=2 childrenFinished=0 stopReg=false
Loop looplIteration=12 childCount=2 childrenFinished=0 stopReg=false
PacedLoop Iteration Delay state Sleeping started=true finishStartec




Custom Code & IEM

* Execute your Java code during the test
* Manage loops (break, continue)

* Perform processing on response from the server and
return results as references for future use

® Run progra mS public String exec (ITestExecutionlervices tes, String[] args) |

int idexpectedl = -1;

int idexpected:zZ = -1;

SJtringbBuffer response = new StringBuffer():

Fandom rand = new Randomi)

Jtring pass = args[0] ;!

if [(pass.equalslgnoreCase ("17)) |
idexpectedl = rand.nextInt():
response.append ("5C OE")

¥ else if (pass.equalslgnoreCase ("29"))] |
Jtring id = "12345";

int nuwm = Integer.parselint(id):;
if (nuwm == idexpectedl) 1

idexpected: = rand.nextlInti(]:
}oelse |

response.append ("5C BAD REQUEST " + idexpectedi):
h

b
return null;




Stop test & Stop user

/4 Stop the user /i Stop the test

throw new RPTStopUserEwvent ("User Stopped): RPTStopTeatEvent stopTest =
hew RPTitopTestEvent ("Test Ztopped");

{f Default iz ERROR

stopTest.zetieverity (MessageEvent . WARNING) ;
{{ No stack trace in the test log
stopTest.zetShowitackTrace (false)

throw stopTest;
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HTTP Page Response Time

* A page consists of several connection streams executing page elements in
parallel

* A page element is one part of the page such as an image or client-side script

* For each page element RPT issues an HTTP request which has a corresponding
response from the server

* Page element response time is the time from first byte sent to last byte received

* The response time for a page connection stream is the total of all of its page
element response times plus any additional time establishing connections, if any

* Page response time is the maximum response time of all page connection
streams
* Processing overhead time is excluded
—Data correlation harvesting
—Action scheduling delays (under stress)
—Custom Code processing

—HTTP processing

1B Soffwarn

Innovate




HTTP Page Response Time Examp

Connection related activty

HTTP related actwity - a page elements first sent to last recerved
Client delay time usually relative to the main HTMLs first recened
The client delay s designed so we don't retrieve a resource
befare the resource is referenced in anather HTML

RPT processing overhead

Simulation Time Analyze Time - RPT processing overhead removed

Time  Connection! Connection? Time  Connection! Connection?

871 0
872 1
2
3
ifls 4
5
B
7
i
9
10
i
12
13
14
15 The page response time is 12
16 the longest activity on any particular stream

Innovate?
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Executive View

= All report data in one RTF

=¥l .

= Apply Filker...

—+1 I

A Edit Filker. .
Femove &l Filkers

add/Remove Performance Counters k

Cuskamize. ..

Cuskormize Colars. ..
(1 Change Time Range...
|5 Display Test Log

Thra

nsole

ﬁ'i Import Resource Monitoring Data. . erver Heal

a Import Response Time Breakdown Data. ..

Tyvpe

Export Report Counters ba C5Y,,,

= Export Test Log
Jid Export Ta HTML...

inn

# Create Executive Summary

Summary Selection

Selected: Charts:2, Tables:2

-] [5& icrveral |

-] [B2l summary

H-[][2& Resources

@ Page Performance Select Al
|:| @ Response ws, Time Summary
@ Response s, Time Dekail
|:| @ Page Throughput:

|:| [2&! server Throughput Select Tables
|:| @ Server Health Summary
|:| [2&! server Health Detail

Deseleck All
Select Charts

Expand Al

IGEY &

Collapse all

< Back [ Mext = l L_Einish ]

—

Cancel

Nex th NOW!




Customizing Reports
* Customize an existing report
—Manage Reports > Expand HTTP Reports > Select Report > Edit

* Create a custom report
—Manage Reports > Create
* Make your custom report the default report
—Window > Preferences > Test > Performance Test Reports > Default Report

B2 Performance Test Runs &2
=.PL Ei_
Manage Feports
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Troubleshooting

* Attempts versus Hits
* Enable Verification Points

o) -
—Look for 100% pass rate Test - stdbench
Page Summary Test Contents Test Elen
This section shows the test contents stdbench
Total Page Atternpks [For Run 1,190 :
g pts [ ] ) £ 0 — | W
Total Page Hits [for Run] 1,190 -, T Add e
Q S Verification Painks J%E.ﬁ_EnaI:ule Content YPs i
L2 50 View - 't} Enable Response Code YPs
Filker » ‘1, Enable Respanse Size YPs
[_jEnal:ule Page Title WPs
Disatle =r
Enable Al
o it
oy Zhr T
[dexk
Paste CErlH
Select Al Chrl+A i Run
Delete Delete
Page Element Summary Add Bookmark. ..
Test Search... Chrl+H
Total Page Elem AL 25
Propetties ——
Ei?l:]ent Page Element WPs Passed [For  |100 Save "stdbench®  ChI4S O Enable re
about "Test"

\ [ Protocol Data &% & Hecarder Cantrol|

IBM Software
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Troubleshooting

: 3>*¢41 = = ||

+ Properties qmerrnr
clement =] .
Verdict & inconclusive

Fai ¢ pass
Time < all
Apr 21, 2009 23427 PMET
Text

IUnable ko determine HTTP skatus-code werification poink because a
complete HTTP response wasn't successfully received,

-y



* Default schedule setting

* Max heap — Windows
—More is not necessarily better
—Default recommended is 1200m
—Limit could be lower (eg 1024m)

* Max heap — Trick for Windows 64-bit

— For max heap up to 1900m change in eclipse.ini
-vm
D:\Program Files\IBM\SDP821\jdk\jre\bin\j9vm\jvm.dl|
to
-vm
D:\Program Files\IBM\SDP83\jdk\jre\bin\javaw.exe

¢ Longer statistics interval




Out of Memory — Agent
* See javacore file for hints

* Measure to determine memory
requirement

—10, 100, 500, 1000, ... users

* Multiple engine on one agent trick




Recovery From Catastrophic Failure
Without Reboot

* Workbench
— Stop and restart RPT
— End stray processes: java, ACServer

» Use Process Explorer and look at command line to identify process so you
http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx

stop RPT related processes:

* Agent
— End stray processes: java, vmstat
— Stop and restart all Agent Controllers

* Linux uses RAStop.sh and RAStart.sh

e Control Panel on Windows
* Windows command line:
—Windows stop command is net stop “ibm rational agent controller”
—Windows start command is net start “ibm rational agent controller”



http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx
http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx
http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx

Forum

e http://www.ibm.com/developerworks/forums/forum.jspa?forumiID

=326

IBM Software

) developerWorks : Rational : Rational Performance Testing - Mozilla Firefox

File Edit Wiew History Bookmarks Tools  Help
@ - c {5t @ Rtk e ibri, comfdeveloperworksForums Forum. jsparforumID=326

IE Most Wisited ’ Getting Started |2 | Latest Headlines

2 - | ® | - |5&arch the Web V| L gearch v Ar T - E] Yideo Histary @ Record Audio 58 Convert

@ developerWorks ; Rational : Rational... 4

Home Solhtions ~ Services - Products ~ support & downloads - My IBM -

developerworks Rational Forurns

Rational Performance Testing B [ voase iy awinterests (ozin v

Search for | | within IRational Parformance |% @
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